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1. Lwu y quan trong

Sé tay st dung dién t& nay danh cho moi
ngwdi dung st dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay trwéde khi st dung man hinh. Sé tay
bao gdm nhirng théng tin va cac lwu y
quan trong lién quan dén viéc s dung
man hinh.

Ché dd bao hanh cla Philips ap dung v&i
diéu kién la san pham phai dwgc st dung
dung cach theo muc dich s dung, theo
cac hwéng dan hoat dong cung véi viéc
xuét trinh hoa don gbc hodc bién nhan
tién mat ghi rd ngay mua, tén ngudi ban,
mau ma va ma sb san xuét clia san pham.

1.1 Lwu y an toan va bao dwéng

® canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu rd trong tai liéu nay cé thé
khién nguwoi dung dé bj dién giat, gap cac
rai ro vé dién va/hodc co hoc.

Hay doc va thuc hién theo cac hwéng dan
sau khi két néi va st dung man hinh may
tinh:

Hoat dong

« Hay dat man hinh & khu vyc khéng cé
anh sang tryc tiép ctia mét, anh sang
ric c6 cwong do manh va cach xa
b4t ky ngudn nhiét nao khac. D&t man
hinh l1au ngay trong mdi trvdng nay cé
thé khién cho man hinh bi bac mau va
héng.

« Di chuyén moi db vat c6 thé roi vao
céc 16 théng gié ctia man hinh hodc
ngan can qua trinh lam mat thich hop
cla céc thiét bj dién t&r bén trong man
hinh.

+ Khoéng bit kin cac 16 théng gio6 trén vo
man hinh.

+  Pam bao d&t man hinh & gan noi cé
phich c&m va & cam dién.

+  Néu tat man hinh bang cach rat cap
ngudn hodc day dién DC, hay doi 6
giay truwéc khi cdm cap ngudn hoac
day dién DC dé& man hinh hoat déng
binh thuwong.

+  Hay ludn dung cap ngudn chuén dwoc
cép bai Philips. Néu thiéu cap ngudn,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tam thong tin tiéu dung
cham séc khach hang)

+ Khéng dat man hinh & noi bi chan
dong hay va cham manh khi dang
hoat dong.

+ Khong dap hoac lam roi man hinh khi
dang hoat dong hoéc khi di chuyén.

Bao dwdng

« D& man hinh khéng bj héng, khéng dé
nén qua manh lIén mat man hinh LCD.
Khi di chuy&n man hinh, hay ndm chét
khung man hinh dé nhéc Ién; khéng
nh&c man hinh bang cach d&t ban tay
hodac ngén tay Ién mat man hinh LCD.

Rt phich cdm man hinh néu ban khéng
dinh str dung né trong th&i gian dai.

« Rt phich cdm man hinh néu ban can
lau chui man hinh bang mét miéng
vai hoi wét. Ban co thé lau man hinh
béng vai kho khi d& ngét dién. Tuy
nhién, drng bao gi& dung dung mai
hiru co, chang han nhw cdn ho&c cac
chét Idng c6 ngudn gbc tir amoniac dé
lau man hinh.

«  Pé tranh nguy co bi dién giat hoac
hdng vinh vién bé man hinh, khéng
dat man hinh & noi ¢d bui, mwa, nwdc
ho&c & noi qua am wot.

« Né&u man hinh bj wét, hay lau né bang
vai kho cang sém cang tét.

« Néu chét la hodc nwéc dinh vao man
hinh, hay ngét dién ngay va rat cap
ngudn. Sau dé lau sach chét la hodc
nwée rdi glvi man hinh dén trung tam
bdo dwdng.



« Khéng cét gi» hodc st dung man hinh
& noi c6 ngudn nhiét, anh néng truc
tiép hoac qua lanh.

« D& duy tri hoat dong téi wu ctia man
hinh va st dung né trong thoi gian dai,
hay dung man hinh & noi ndm trong
gi6i han nhiét dd va d6 4m sau.

+ Nhiét do: 0-40°C 32-95°F
+ D06 &m: 20-80% RH

Théng tin quan trong vé Thir néng/Anh

béng ma.

e Luobn bat trinh bao vé man hinh
chuyé&n déng khi ban khéng str dung
man hinh. Ludn bat vng dung lam mai
man hinh dinh ky, néu khéng, man
hinh ctia ban sé hién thi nhirng noi
dung tinh khéng thay déi. Hién thj lien
tuc cac anh tinh trong mét thoi gian
dai cc’> thé& gay ra hién twong “anh thiy
néng”, con dwoc goi la “anh ao” hay
“anh béng ma”, trén man hinh cua
ban.

“Anh thtr néng”, “Anh a0” hay “Anh
béng ma” 1a hién twong phd bién trong
céng nghé man hinh LCD. Trong hau
hét cac trwong hop, hién twong “anh
thlr ndng” hodc “anh 40" hay “anh
béng ma” sé& dan dan bién mét sau
mot thoi gian man hinh bi ngat dién.

® canh bao

Khong thé bat anh bao vé man hinh, hoac
wng dung cap nhat man hinh dinh ky co
thé gay ra cac sw cb “thtr néng” hodc “anh
sau” hodc “anh béng ma” nghiém trong
vbn s& khong bién mét va ciing khéng

thé khac phuc. Thiét hai vira néu khong
bao gdm trong chinh sach bao hanh cta
chung toi.

Dich vu

« Chinhan vién dich vu chuyén mon
m&i dwoc mé vo boc man hinh.

«  Né&u can moi tai liéu hwéng dan dé
stra chira hoac tich hop man hinh,
hay lién hé v&i trung tdm dich vu tai

dia phwong ban. (vui long tham khao
chwong “Trung tdm thdng tin tiéu
dung”)

+ D& biét thong tin vé& viéc van chuyén,
vui Idng tham khao muc “Théng sé k§
thuat”.

« Khéng dat man hinh trong xe hoi/cép
xe dwdi anh nang truc tiép.

& Ghicha

Hay tham khao y kién cla ky thuat vién
dich vu néu man hinh khéng hoat déng
binh thwdng hodc néu ban khéng chéc
phai thwe hién quy trinh nao khi da lam
theo cac hwéng dan hoat déng néu trong
s6 tay nay.

1.2 M6 ta biéu twong

Cac muc phy sau day mé ta cac quy woc
vé biéu twgng dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bd sb tay nay, cac doan chi®
c6 thé di kém biéu twong va dwoc in dam
hodc in nghiéng. Cac doan nay bao gbém
cac ghi chu, lwu y hoac canh bao. Ching
dwoc str dung nhu sau:

& Ghicha

Biéu twong nay cho biét cac thong tin
quan trong va cac bi quyét giup ban tan
dung tét hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac thong tin gitp
ban biét cach tranh dwoc sw ¢ héng héc
tiém &n dbi v&i phan clrng hodc mat di
lieu.

® canh bao

Biéu twong nay cho biét sy tén thwong
co thé tiém an va gidp ban biét cach tranh
dwoc sw cd do.

M6t s6 canh bao co thé xuét hién & nhiéu
dinh dang va co6 thé khong di kém mot
biéu twong. Trong nhirng tredng hop nay,



céach thirc trinh bay cu thé cia canh bao
doé dwoc quy dinh b&i co quan chirc nang
lién quan.

1.3 Virt bé san pham va vat liéu
déng goi

Thiét bj dién & dién ter bj virt bo-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page



2. Cai dat man hinh Hl Lipchandé ‘
. Dejt man hinh nam sap trén bé mét‘
mém min, can than dé tranh lam tray

-

2.1 Lap dat xwdc hodc héng man hinh.
2. Géan/truot than dé vao man hinh cho
1] Noi dung go6i hang dén khi né khép vao vi tri.

Smjtart

PHILIPS

3. Gitr chan dé man hinh bang cé hai tay
va lap chat chan de vao tru de.

Power Cable *VGA Cable

* Tuy vao qubc gia



El Két néi véi PC
203V5LSB/203V5LSU/203V5LSB2/203V5LSU2

PHILIPS

© Dau vao ngudn dién AC
© Diu vao VGA
© Khoa chdng trom Kensington

203V5LHSB2

PHILIPS

o0

@ '[—}HT]J

y

@ Dbiu vao ngudn dien AC

© Diu vao VGA

© Diu vao HDMI

0 Khoéa chéng trdbm Kensington

Két néi véi PC

1. Cam chét cap ngudn vao mat sau cla
man hinh.

2. Tat may tinh va rat cap ngudn.

3. C&m cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

4. C&m cap ngudn clia may tinh va cap
nguon cdia man hinh vao 6 cam dién
gan do.

5. Bat may tinh va man hinh. Néu man
hinh hién thi h‘lnh anh thi qua trinh cai
dat da hoan tat.

2.2 Str dung man hinh

El M6 ta mat trwéc cha san pham

or

o

————
El Mb ta menu Hién thj trén man hinh
Hién thj trén man hinh (OSD) la gi?
Hién thi trén man hinh (OSD) la mét tinh
nang cé & moi man hinh LC‘D cua Philips.
N6 cho phép nguwoi dung dieu chinh hoat
dong ctia man hinh hoac qhon cac chirc
nang clia man hinh trwee tiép thong qua
mot clra s& hwéng dan hién thi trén man
hinh. Mét giao dién r]ién thi trén man hinh
dé st dung_dwo’c thé hién nhuw sau:

203V5LHSB2:

d) BAT vaTAT ngudn man hinh.

-@ Déi ngudn vao tin hiéu.

'U' Chinh d6 sang.

I:- Chinh d6 tuong phan.
AUTO | Tu déng chinh man hinh.

Thay d8i ngdn nglt

(D Hién thi thong tin

D Thodt menu OSD




Cach chinh OSD chi bang mét nat? Menu OSD

1. Nut & duoi mét truée man hinh cung cép Dui day la tbng quan vé co cAu cla
chtre nang kép dé bat/tat ngudn va chinh stra menu Hién thi trén man hinh. Ban co thé
cai dat menu OSD. st dung co' c&u nay lam théng tin tham
khao khi muén thuc hién cac diéu chinh
khac sau nay.

Main menu
———————n

VGA
—Input E DVI (available for selective models)

. 3 HDMI (available for selective models)
2. Bat man hinh bang cach nhan nat & dwéi
mot lan. Pict r— Picture Format — Wide Screen, 4:3
—Ficture
3. Bay gid nhén lai nit & dwéi mat treée man [ Brightness — 0-100
hinh dé vao menu OSD. [ Contrast — 0100
t— SmartContrast —— On, Off
L— OverScan — On, Off
== - '. ——=> L Audio — Volume — 0~100
(available for — Mute — On, Off
193V5LHSB2: selective models) L—  Aydio Source — Audio In, HDMI
+—Color r— Color Temperature — 6500K, 9300K
== _———— |— sRGB
U . - . A L— User Defi Red: 0~100
4. Bay gio ban co thé chon mét trong cac ser meine E Green: 0~100
chirc nang bang cach nhan nhanh nhiéu lan nat Blue: 0~100
& dudi. O mau xanh sé ChUyen sang phal khi —Language — English, Deutsch, Espafiol, ENnvik, Frangais, Italiano,
ban nhan nut. Ban cé the tha nat & dwoi mot Maryar, Nederlands, Portugués, Portugués do Brazil,
khi 6 mau xanh boi dam tl]y chon ma ban mong Polski , Pycckuit, Svenska, Suomi, Tirkge, Cestina,
muén. Lwu y rang day 1a vong lwa chon mot Vipaitcoia, BIRERSC, SRR ST HARRE, 9o
chiéu vén ludn di chuyén theo mét chiéu va rdi
tr& lai tir dau menu. +—OSD Settings — Horizontal — 0~100
5. O mau xanh sé& van hién thj & chirc ndng [ Vertical — 0~100
dwoc chon khqéng 3 giéy‘vé bi(au twong chirc — Transparency — Off,1,2,3,4
nang dé sé nhap nhay 3 lan nham xac nhan S 105 205 305, 60
> R . 2 . . e _ i — S, s, S, s, S
Iwa chon cha ban hién thi & I&6p thir nhat trong ©OSD Time Out
menu OSD va béat chirc nang dé.
z ~ ~ X £ , —Setup — Auto
6. Dé chon ngdn nglr mong mudn, nhan nut
— H. Position — 0~100

& dudi, chon biéu twong “‘Qué cau” trong menu
OSD va bat chirc nang. Nhieu tgy chon ngén — V. Position — 0~100
ng sé hién thj trong menu. Nhan lai nit & dudi

N R . N - e — Ph — 0~100
va duyét qua danh sach ngén ngir. Thoat khoi ase
menu khi 6 mau xanh hién thj & ngén ngir mong — Clock — 0~100
muon sé chon va bat ngén nglr d6. Resolution
. . . N . [ Notification — On, Off
7. Dé& chinh do sang hoac do twong phan,
— Reset — Yes, No

nhan nat & dwdi, chon va bat chirc nang d6.
Nhan lai nat & dwdi dé diéu chinh. Lwu y réng L Information
day la vong Iwa chon mot chiéu vén ludn di

chuyén theo mot chiéu va rdi tré lai tr dau

menu.




El Théng béo vé dé phan giai 2.3 Thao dé va chan dé
Man hinh nay dwoc thiét ké d& hoat déng

t6i wu véi d6 phan giai gbc 1a 1600 x 900 E Thao chan gé

@ 60 Hz. Khi dwgc chinh sang d6 phan Trwée khi bat dau thao chan dé man
gidi khac, man hinh sé hién thi mot thong hinh, hay thwc hién theo cac hwéng dan
bao: Dung 1600 x 900 @ 60 Hz dé dat két bén dwdi dé tranh moi thiét hai hay chan
qua tét nhéat. thwong cé thé xay ra.

1. Dat man hinh nam s&p trén bé mat
min, c&n than dé tranh lam trdy xwéc
El Tinh nang vat Iy hoc hédng man hinh.

Nghiéng

2. An vao cac kep khéa dé thao chan dé
ra khai tru dé.




& Note
This monitor accepts a T00mm x 100mm VESA-
Compliant mounting interface.

PHILPS

100mm

100mm,




3. T6i wu héa hinh anh

3.1 SmartContrast

B ps1agi?

Cong nghé ddc dao vén linh hoat phan
tich ndi dung hién thj va tw dong tbi wu
héa ty I&é twong phan cia man hinh LCD
dé mang lai d6 rd nét va trai nghiém xem
tbi wu, ting mirc dén nén dé hién thi
nhirng hinh anh sang ré hon, séc nét hon
va sbng dong hon hay gidm mdc dén nén
@& hién thj rd hinh &nh trén phéng nén téi.
H Sao t6i phai can n6?

Ban mudn hién thi ndi dung rd nét cung
cam giac thodi mai nhat khi xem moi loai
ndi dung. SmartContrast sé linh hoat chinh
dé twong phan va mirc dén nén dé hién
thi nhirng hinh anh choi game hay video
cwe rd, sdng dong va sac nét hay hién thi
ndi dung chir rd rang dé doc cho céac tng
dung van phong. Bang cach gidm viéc tiéu
thu dién ctia man hinh, ban sé tiét kiém
dworc chi phi ndng lwong va kéo dai tudi
tho cho man hinh cuta ban.

E cach hoat dong?

Khi ban bat ché d& SmartContrast, né sé
phan tich néi dung dang hién thj trong
thwe té dé chinh mau séc va mat do den
nén. Chirc ndng nay sé linh hoat tang
do6 twong phan dé mang lai cho ban trai
nghiém giai tri tuyét v&i khi xem video
hoac choi game.

3.2 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i cta
Phillips cho phép ban diéu khién man hinh
qua giao dién dd hoa o tién dung. Cac
didu chinh phtc tap la nhirng gi thudc

vé qua khir vi phan mém than thién voi
nguoi dung nay sé huéng dan ban qua
viéc tuy chinh do phan gidi, hiéu chinh
mau, diéu chinh déng hd/géc pha, diéu
chinh diém trang RGB (Dé-Luc-Lam), v.v...

Trang bi cdng nghé méi nhét vé thuat toan

I6i xC Iy va phan &ng nhanh, phan mém

chay bang anh déng b4t mat thuong thich

véi Windows 7 nay sén sang nang cao trai

nghiém cuta ban v&i man hinh Philips!

E cai aat

«  Thuwc hién theo chi dan va hoan tat quy
trinh cai dat.

+ Ban c6 thé kh&i dong phdn mém sau
khi hoan tat cai dat.

« Néu mubdn kh&i ddng sau, ban c6 thé
click phim tat phdn mém trén man hinh
nén hodc thanh céng cu may tinh.

PHILIPS www philips.com/welcome

Y —

Wizard (Thuat si) kh&i dong lan dau

 Lan dau khi cai d&t phan mém
SmartControl Lite, n6 sé ty dong vao
Wizard (Thuat si) khi déng lan dau.

+ Thuat s nay s& hwdng dan ban théng
qua viéc diéu chinh tirng buéc vé hiéu
suét man hinh.

+ Sau nay ban ciing c6 thé vao menu
Plug-in (B4 sung) dé bat thuat si.

« Ban c¢6 thé chinh cac tuy chon khac
qua giao dién Standard (Chuan) ma
khong can thuat si.



 smartcontrol

SmartControl Lite

¥
Options Presets
Muti Monitors
Help

2 -Phips 225B1 (CS30715000001) ()X,
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Start Waard

Bl Khéi dong bang giao dién Standard
(Chuén):

Menu Adjust (Diéu chinh):

Menu Adjust (Diéu chinh) cho phép
ban chinh Brightness (D6 sang),
Contrast (B¢ twong phan), Focus
(Trong tam), Position (Vi tri) va
Resolution (D6 phan giai).

Ban cé thé lam theo chi dan va thuc

hién diéu chinh.

Lénh Cancel (HUy) s& hoi nguoi dung
xem ho cé muodn hay tién trinh cai dat

hay khong.
B smartcontrol

SmartControl Lite

&

Adiust

Brightness

= 2

Color

1<~ SIS

Options o

Resolution

S

Hep

2 - Philps 22581 (C$30715000001) |2\ X)
PHILIPS

Brightness

operly adjusted Brightness wil result i 3 loss of
il 1 darker image ares. Adjust the Brightness for
picture qualty

the Brightness to the mnimum level
Brightness to the desred |

Adjust the Brightness as needed to achieve
an equal separation of the stripes.
Brightness 100
- +
Undo Reset.

W smartcontol

SmartControl Lite

Adjust.
Brightness
Contrast
Color 2
A
” Focus
22N
\g Postion
Optons
Resolution
Help
8 smartControl

SmartControl Lite

Adjust.
Brightness
Contrast
Color ,/%%
Vo 2l
3 Focus
22N
\g Postion
Optons Py
Resolution

Help

8 smartcontrol

SmartControl Lite

Adjust.
Brightness
Contrast
Cobor =
A
Focus
; !
\, Postion
Options 4
Resolution
Help

2-phips 22581 (cs30715000001) (Z](X
PHILIPS

Contrast

the Contrast (use the sider) to keep detais in
Rge areas.

e Contrast unt the numbers 1 and 2
are no bonger visble.

Slo Contrast to make the

d 3 reappear. The number 1
should remain barely visble

Undo Reset.

2 - Phiips 22581 (CS30715000001) {F\X

PHILIPS

timing needs to be synchronized with

sqnal

& Auto Setup.

rtical bands are stil visble, you'l need
he Pitch.

L ch
2. Ifthe

o

pitch: Try

iech 50
- +
Phase 17

Undo Auto Setup

2-phios 22581 (cs30715000001) (Z](X

PHILIPS

Position

@ Up/Down buttons to center the image

ticaly,
2. Use the Left/Right buttons to center the image
horzontaly

Undo Reset.



@ smartcontol

Menu Color (Mau):

SmartControl Lite

Brightness

Contrast

)

g

)
g
£
g

2-phios 22581 (cs30715000001) (F1X
PHILIPS

Resolution

You are currently at a Preferred resolution. For your
disply to o car text, colors, and mages,
Your display should be set to fs Preferred resolution.

T your display s at a Non-Preferred resolutin, click
on the Preferred button to change your resolution to
I Enable Resolution Notifer

Picture Format
I 43 asect ratio

JH

Menu Color (Mau) cho phép ban chinh
mau RGB (Dé-Luc-Lam), Black Level
(Do tbi), White Point (Diém tréng),
Color Calibration (Hiéu chinh mau).
Ban co thé 1am theo chi dan va thuc

hién diéu chinh.

Tham théo bang bén dudi dé hinh
dung co ban vé muc menu phu trén
théng tin nhap cua ban.

Vi du Color Calibration (Hiéu chinh

mau s&c):
8 smartcontrol

SmartControl Lite

-

Adjust RGB
g M
Color White Pont
T “
Display Gamma
-
Options. Galbration
Help

2-Phips 22581 (cs30715000001) (]
PHILIPS

Black Level

Improperly adjusted Black Level wil resut i 3 loss of
detai n darker mage areas. Adjust the Black Level for
the best possble picture qualty.
1. Adjust the biack level of the Red, Green, and
Blug usng the sider bars.

Red 50
= L
Green 50
= - &
Ble 50
= e/

Undo Reset.
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@ smartcontol

SmartControl Lite

&

Adijust RGB
Color White Pont
—— “
Display Gamma
-
Options. Galbration
Help

W smartcontrol

SmartControl Lite

-

Adjust RGE
Color Whte Pont
Disply Gamma
-
Options. Galbration
Help
8 SmartControl

SmartControl Lite

RGB
Back Level
white Pont

Dsply Gamrma

Calbration

Help

2-Phips 22581 (cs30715000001) (]
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White Point

hich equal combinations
full ntensty create

White Point s the pon
of red, green, and blue f
white. This effects the overal color quaity. For the
most accurate colors cick the Reset button then
select the Whie Point.
1. Please select the White Point value for the best
possble color qualty.

Wnite Point 6500K
= < +

Undo Reset.

2-Phips 22581 (CS30715000001) \Z)X)
PHILIPS

Display Gamma

Gamima is 3 component of the pixel brightness in a
disply. A lower Gamma value produces brighter pixels
and a higher Gamma vakue produces darker pixes. The
defauk vakie for Gamma is 2.2

To adjust Gamma, Smartimage must be set to OFf.
Gick the Smartimage Off button before adjusting
Gamma.

1. Use the sider to select the desred Gamma.

Dsply Gamma 22
o .
Smartimage Off
undo Reset

2 - Phiips 22581 (C530715000001) (T} X
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Calibration

properly calibrated in order
e

Your display needs to

step i the process. Remember to recalbrate any time
You make ndiidual adjustments to mage qualty or
whenever you move your dsplay to a new locatin.

Make al other necessary adjustments to image
qualty first.
Press Show Me to leam how to use the

2
calibration took.
3. Finally, press Start to begi the calibration

¥ Enable cobor calbration
Color software designed in colaboration with Joseph
Holes.

Protected by U.S. Patent lio. 6,686,953

Show Me start

Quick View



. “Show Me” (Cho t6i xem) sé& bat
hwéng dan hiéu chinh mau.

. Start (Bat dau) - bat dau quy trinh
canh chinh mau qua 6 buwéc.

. Quick View (Xem nhanh) tai cac hinh
anh trwdc/sau.

. Tré& vé giao dién chinh Color (Mau),
click nat Cancel (Huy).

. Enable color calibration (Bat hiéu
chinh rpéu) - theo mac dinh la dwoc
bat. Néu khéng chon muc nay, ban
khong dwoc phép hiéu chinh mau va
tat cac nat khéi dong va xem nhanh.
. Phai c6 théng tin béng sang ché trén
man hinh hiéu chinh.

Man hinh hiéu chinh mau dau tién:

Nt Previous (Trwéc) sé tat cho dén
khi man hinh mau th& hai bat 1én.
Next (K& tiép) s& chuyén vao muc tiéu
tiep theo (6 muc tiéu).

Cubi cuing, vao giao dién File>Presets
(File>Cai san).

Nut Cancel (Hly) sé déng giao dién
nguwdi dung (Ul) va tré vé trang bd
sung.
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Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat dong khi chon
Preferences (Ju tién) ttr menu Options
(Tuy chon) s xuéng. Trén man hinh
khéng hé tro twong thich véi chuan DDC/
Cl, chi ¢6 sén céac thé Help (Tro giup) va
Options (Tuy chon).

'8 smartControl 2 - Philps 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

« Hién thi cac cai dat wu tién hién hanh.

« O vira chon sé& bat tinh néng nay. O
chon la nat bat/tat.

» Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh)
hién thi cac lwa chon SmartControl
Lite cho Select Preset (Chon cai sén)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (D3 tét)
sé x6a SmartControl Lite khéi menu
thudc tinh click phai.

+ Biéu twong Enable Task Tray (Bat
khay tac vu) dwoc chon la (Bat) theo
mac dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thj cac tuy chon menu
cho Help (Tro giup), Technical Support
(H6 tro’ ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi d& tat Enable task tray



menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thi EXIT
(THOAT).

e Theo mac dinh Run at Startup (Chay
khi khé&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé khong
bat khi khéi dong hodc nam trong
khay tac vu. Cach duy nhat dé bat
SmartControl Lite 1a ttr phim tét trén
man hinh nén hoéc ti file chuwong
trinh. Bat ky bo cai dat sdn nao dé
chay khi kh&i dong sé hoat déng
khéng tai khi 6 nay khong dwoc chon
(Pa tat).

+ Enable transparency mode (Bat ché
do trong subdt) (Windows 7, Vista, XP).
Mac dinh Ia 0% Mo.

Options>Input (Tuy chon>Nhap) - Sé

chi hoat déng khi chon Input (Nhap) ti

menu Options (Tuy chon) sé xudng. Trén
man hinh khéng hé tro twong thich véi
chuén DDC/CI, chi ¢ s8n cac thé Help

(Tro gitp) va Options (TUy chon). T4t ca

céac thé SmartControl Lite khac déu khong

c6 san.

W smartcontrol

2 - Phiips 22581 (C$30715000001) (1] X

PHILIPS

SmartControl Lite

Adiust i 4

resets

Analog In Digial In

+ Hién thi giao dién hudng dan Source
(Nguon) va cai dat nguon nhap théng
tin hién hanh.

* Trén cac man hinh nhap riéng, giao
dién nay sé khong hién thi.
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Options>Audio (Tuy chon>Am thanh)
- Sé& chi hoat déng khi chon Audio (Am
thanh) tr menu Options (Tuy chon) sb
xubng.

Trén man hinh khéng hé tro twong thich
v&i chudn DDC/CI, chi co sén cac thé
Help (Tro giup) va Options (Tuy chon).

B SmartControl 2 - Phiips 22581 (C530715000001) ()X,

SmartControl Lite PHILIPS

Options

L

Help

Help>User Manual (Tro’ gitip>S6 tay stv
dung) - Sé chi hoat dong khi chon User
Manual (Sb tay st dung) t& menu Help
(Tro gitip) s6 xubng. Trén man hinh khong
hé tro twong thich véi chudn DDC/CI, chi
c6 sén cac thé Help (Tro giup) va Options
(Tay chon).

' smartControl 2.- Philps 22581 (C530715000001) | 2)(X)

SmartControl Lite PHILIPS

User Manual

Tech. Support



Help>Version (Tro gitip>Phién ban) - S&é
chi hoat déng khi chon Version (Phién
ban) tr menu Help (Tro gitp) sé xubng.
Trén man hinh khéng hé tro' twong thich
véi chudn DDC/CI, chi c6 sén cac thé
Help (Trg gitp) va Options (Tuy chon).

8 smartcontrol 2-Phips 22581 (CS30715000001) (2%

SmartControl Lite PHILIPS

Tech. Support

Menu nhay cam vé&i thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thuéc tinh) sé& dwoc Bat. Néu
da chon Enable Context Menu (Bat thuéc
tinh) trong giao dién Options>Preferences
(Tuy chon>UWu tién) thi menu nay sé hién
thi.

@ SmartControl
Select Preset 3
Tune Display

Menu Thudc tinh c6 ba muc nhéap:

« SmartControl Lite - khi da chon, About
Screen (V& man hinh) s& hién thj.

+ Select Preset (Chon cai dat sén) -
Cung cAp menu cac muc cai san da
lwu theo trinh ty dé& s dung ngay.
DAu kiém sé& hién thi muc cai sdn hién
da chon. Muc Factory Preset (Cai sén

14

gbc) cling c6 thé duoc chon tir menu
s6 xubng.

* Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

+  Smartlmage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

Da bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu
bang cach click phai vao biéu twong
SmartControl Lite ttr khay tac vu. Click trai
sé bat (rng dung.

Help

Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

* Help (Trg giup) - Truy céap file User
Manual (Sé tay st dung): M& file User
Manual (Sé tay st dung) qua ctra sb
trinh duyét mac dinh.

+ Technical Support (H8 trg’ ky thuat) -
hién thj trang hé tro ki thuat.

+  Check for Update (Kiém tra cap nhat)
- d&n nguwoi diing dén Nén (rng dung
PDI va kiém tra phién ban clia nguoi
dung so vé&i phién ban c6 s&n méi
nhét.

* About (V&) - Hién thi thong tin tham
khdo chi tiét: phién ban san pham,
théng tin vé phién ban va tén san
pham.

» Exit (Thoat) - Béng SmartControl Lite.

pé chay lai SmartControl Lite, hdy chon
SmartControl Lite ttr menu Program
(Chwong trinh), click ddi biéu twong PC
trén man hinh nén hoac khai dong lai hé
théng.



PHILIPS

SmartControl

‘SmartControl
‘ersion 3.20
ctune-stanciard-R2007-01-04-1151-23
Copyright 1993-2007 Pertrat Displaye, Inc.
Paterts Pending

P4 tat menu khay tac vu

Khi da tat Khay tac vu trong thu muc

wu tién, chi con co sén Iwa chon EXIT
(THOAT). Bé& x6a hoan toan SmartControl
Lite khoi khay tac vu, hay tat Run at
Startup (Chay khi kh&i dong) trong
Options>Preferences (Tuy chon>Uu tién).

equy

Tét ca cac hinh minh hoa trong phan
nay chi dwoc dung dé tham khao. Chuing
t6i co thé thay ddi phién ban phan mém
SmartControl ma khéng can théng bao
trwde. Vui long ludn truy cap trang web
chinh thrc cta Portrait tai www.portrait.
com/dtune/phl/enu/index dé tai vé phién
ban phan mém SmartControl m&i nhét.
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4. Cac théng sé ky thuat

Loai mat man hinh TFT-LCD

DPén nén LED

C& man hinh Roéng 19,5 inch (49,4cm)

Hé sé co 16:9

Do pixel 0,26 x 0,26 mm

B0 sang 200 cd/m? for 203V5LSB2/203V5LSU2/203V5LHSB2;

250cd/m? for 203V5LSB/203V5LSU
Do twong phan théng minh 10,000,000:1

Do twong phan (chuan) 600:1

Thoi gian dap (rng (chuén) 5ms

D6 phan giai toi wu 1600 x 900 @ 60Hz

Goc xem 90° (H) / 50° (V) @ C/R > 10

Mau man hinh 16,7 triéu mau

Tbc d6 phat doc 56Hz - 76Hz

Tan s6 ngang 30kHz - 83kHz

sRGB (Pé-Luc-Lam chuidn) | CO

DAu vao tin hiéu VGA (Analog)(203V5LSB/203V5LSU/203V5LSB2/203V5LSU2);
HDMI(203V5LHSB2)

Tin hiéu vao Déni bod riéni, E)E“)ni bo véi tin hiéu xanh luc

Tién ich cho ngudi dung 0]

Tiéng Anh, Tiéng Burc, Tiéng Tay Ban Nha, Tiéng Hy Lap, Tiéng
X Phap, Tiéng Y, Tiéng Hungary, Tiéng Ha Lan, Tiéng B6 Pao
Ngén nglr OSD (Hién thj trén | Nha, Tiéng B6 Dao Nha Brazil, Tiéng Nga, Tiéng Ba Lan, Tiéng

man hinh) Thuy Dién, Tiéng Phan Lan, Tiéng Thd Nhi Ky, Tiéng Séc, Tiéng
Ukraina, Tiéng Hoa gian thé, Tiéng Hoa phon thé, Tiéng Nhat,
Tiéng Han

Lap VESA 100 x 100 mm

Tién ich khac Khoa Kensington

Twong th[ch véi chuan Plug | DDC/CI, sRGB, Windows 8/ Windows 7/ Vista/XP, Mac
& Play (Cam vao la phat) OSX, Linux

Nghiéng -3/+10
Ché d6 bat 203V5LSB2/203V5LSU2: 15,8W (chuan), 16,71W (t6i da)

203V5LSB/203V5LSU: 18.29W (chuén), 18.98W (t6i da)
203V5LHSB2: 17.69W (chuén), 18.46W (tbi da)

Ché dd ngu (cho) 0,5W

Tét 0,5W

DPén bao LED ngudn Ché do bat: Ché d6 Trang, Cho/Ngu: Trang (nhap nhay)
B6 nguE‘)n Thir néng, 100-240VAC, 50-60Hz
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San phdm kém theo dé gity
(Rong x cao x day)

465 x 345 x 169 mm

San pham khong kém theo
dé gi» (Rong x cao x day)
Trong lwong

465 x 282 x 48 mm

San pham kém theo dé gitr 2,33kg(LED)
S?n .eham khéng kém theo 2,03kg(LED)
de gitr

San pham déng goi 3,23kg(LED)

Diéu kién hoat dong

binh gilra cac sy cd)

Pham vi nhiét d¢ (hoat dong) | 0 °C -40 °C
Pham vi nhiét d (Khong 20 °C - 60 °C
hoat dong)

Do am twong déi 20% - 80%
MTBF (Thoi lvong trung 30.000 gi®(LED)

Chi thi ROHS (Gi¢i han cac

Tuan tha va tiéu chuan

Phé chuén theo quy dinh

chét gay hai) €9
EPEAT Bac (www.epeat.net)
Thung dung Co thé tai ché 100%
Energy Star coO

CE Mark, FCC Class B, CU, SEMKO, ETL, 1SO9241-
307, SASO, EPA, CB, PSB, KUCAS, TBS CoC

Mau Den
L&p son ngoai Hoa van

& Ghi chu

1. Vang hay bac EPEAT chi ¢6 hiéu luc tai noi ma Philips da d&ng ky san pham. Hay truy

cap www.epeat.net dé biét tnh trang d&ng kw tai quéc gia ctia ban.

2. DU liéu nay chiu sw thay di ma khong can théng bao trwde. Truy cap www.philips.com/

support dé tai vé& phién ban td roi méi nhét.




4.1 Ché do do phan giai & cai
dat san

Do phan giai téi da
1600 x 900 @ 60 Hz

Tansé Do phangidi Tan sb doc

ngang (kHz) (Hz)
3147 720 x 400 70.09
3147 640 x 480 59.94
35 640 x 480 66.67
37.86 640 x 480 72.81
375 640 x 480 75
37.88 800 x 600 60.32
46.88 800 x 600 75
48.36 1024 x 768 60
60.02 1024 x 768 75.03
44.77 1280 x 720 59.86
63.89 1280 x 1024 60.02
79.98 1280 x 1024 75.03
60 1600 x 900 60
& Ghi chu

Lwu y réng man hinh cta ban hoat déng
tbt nhat & do phan giai gbc 1600 x 900 @
60Hz. D& c6 chét lwong hién thi tot nhét,
hay dung d6 phan giai khuyén nghi nay.



5. Quan |y nguén dlén Cai d&t sau day duoc dung dé do mirc

Néu ban da cai dat card man hinh hay tiéu thu dién trén man hinh.

phan mém twong thich chudn VESA DPM * D¢ phan giai gbc: 1600 x 900
vao PC, man hinh c6 thé tw ddng giam * Do twong phan: 50%
tiéu thu dién khi khdng st dung. Néu phat « Do sang: 200 nit or 250 nit

hién nhap tr ban phim, chudt hay thiet bi - Nhiét do mau: 6500k voi kiéu mau
nhap khac, man hinh sé “hoat dong” tw < [
trang day du

doéng. Bang sau day sé hién thi mdoe tiéu

thu diér) va cach truyén tin hiéu cla tinh (=) Ghi chu
nang tiét kiém dién tw dong nay: D@ liéu nay chiu su thay dbi ma khong
203V5LSB2/203V5LSU2(Analog only) can théng bao trude.

Binh nghia quan ly ngudn dién
Ché do Vits Pong bd| Bdng | Ngudn dién | Mau dén
VESA ngang | bd doc str dung LED
15,8W.
. X X (chuan), “
Hoat dong| BAT Co Co 16,71W (t6i Trang
da)
. Trang

Che dd | 14T | Knong | Khong [0,5W (chudn)|  (Nhép

ngu (cho) nhéy)
Tét TAT - - |0,5W (chuan)| TAT

203V5LSB/203V5LSU

uan ly nguén dién

Ché do Pong bd| Bdng | Ngudn dién | Mau dén

VESA Vize ngang | bd doc str dung LED
18.29W
. X X (chuan), “
Hoat dong| BAT Co Co 18.98W (t6i Trang
da)
. Trang
Che dd | 14T | Kneng | Khong [0,5W (chudn)|  (Nhép
ngu (cho) nhéy)
Tét TAT - - |0,5W (chuan)| TAT
203V5LHSB2

uan ly nguén dién

Ché do Poéng bo| Bdng | Nguén dién | Mau dén

VESA Video ngang | b doc str dung LED
17.69W
. . X X (chuén), 2
Hoat dong| BAT Co Co 18.46W (t6i Trang
da)

£ Tréng
Che 80 | 147 | Khang | Kheng [0,5W (chun)|  (Nhép
ngu (cho) nhéy)
Tét TAT - - |0,5W (chudn)| TAT
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6. Théng tin quy
dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery

¥ and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

EPEAT

(www.epeat.net)
£ The EPEAT (Electronic

Product Environmental

2 Assessment Tool) program

evaluates computer

desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
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means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:2010 (Immunity requirement of
Information Technology Equipment).

e EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

»  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

*  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 15S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

»  GS EK1-2000:2011 (GS mark requirement).

prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
-

have determined that this product



meets the ENERGY STAR® guidelines for
energy efficiency.

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic
Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf|
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

() ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Dich vu cham séc
khach hang va bao
hanh

7.1 Chinh sach 16i diém anh
man hinh phéng cua Philips
Philips cb géng cung cAp cac san phdm
chat lvong cao nhét. Chung t6i ap dung
mét sé quy trinh san xuét tién tién nhét
trong linh vuc va thwe hién quy trinh kiém
tra chét lwong nghiém ngat. Tuy nhién, cac
I6i diém &nh hay diém anh con trén man
hinh TFT dung trong cac man hinh phang
dbi khi khong thé tranh khai. Khéng nha
san xuat nao cé thé dam bao réng moi man
hinh s& khong ¢ cac 16i diém &nh, nhwng
Philips dam bao réng bét ky man hinh nao
c6 mot sb 16 khong thé chap nhan sé duoc
stra chira hoac thay méi dwa vao chinh
sach bdo hanh. Thong bao nay giai thich
nhirng kiéu 16i diém anh khac nhau va dinh
nghia cac mirc 16i cé thé chap nhan cho
mai kiéu 16i. Dé hwdng dich vu stra chira
hay thay thé theo chinh s&ch bao hanh, sé
lwong 16i diém &nh trén man hinh TFT phai
vuwot qua cac mie chap nhan nay. Vi du,
khéng qua 0,0004% diém anh con trén man
hinh c6 thé bj I6i. Ngoal ra, Philips tham
con dat ra cac tiéu chuén chét lwong cao
hon cho mét s6 kidu hay két ho’p 16i diém
anh vbn dé& nhin thay hon cac kiéu 15 khac.
Chinh sach nay cé hiéu Iyc trén toan cau.

diém  didm  didm
anh phu anh phu anh phu

H H \x
diem
anh

DPiém anh va diém anh con

Diém anh hay phan t&¢ anh gébm ba diém
anh con trong cac mau chinh dd, luc va
lam. Nhiéu diém &nh cting tao thanh hinh
anh. Khi moi diém &nh con cia mot diém
anh sang lén, ba diém anh con co mau sac
cuing hién thi nhw mot dlem anh trang don
1&. Khi moi diém &nh con t6i mo, ba diém

anh con ¢6 mau sac cung hién thi nhw mot
diém &nh den don 1&. Nhiing két hop diém
anh con sang va toi khac hién thi nhw cac
diém anh don 18 tr nhitng mau khac.

Cac kiéu 16i diém anh

Cac 16i diém &nh va diém anh con hién thi
trén man hinh theo nhirng cach khac nhau.
C6 hai kiéu 16i diém anh va nhiéu 16i diém
anh con trong méi kiéu 18i.

Cac 16i cham sang

Céc 16i chdm sang hién thi duoi dang cac
diém anh hay diém anh con vén ludn sang
hay “bat”. Nghia la mon ch&m sang 1a mot
diém anh con vén ndi Ién trén man hinh khi
man hinh hién thi kiéu hinh t6i m&. C6 cac
kiéu 16i chdm sang.

Mbt diém &nh con sang dd, luc hay lam.

W

Hai didm anh con sang gan nhau:
- Do +Lam =Tim
- Dod + Luc =Vang

- Luc + Lam = Luc lam (Lam nhat)




Ba diém &nh con sang gan nhau (mat diém
anh tréng).

& Ghi chu

Chéam sang dé hay lam phéi sang hon
50% so v&i cac chdm xung quanh trong
khi chdm sang luc sang hon 30% so véi
cac chdm xung quanh.

Cac 16i cham den

Cac 16i cham den hién thj dwéi dang cac
diém anh hay diém anh con vén luén toi
mo hay “t&t”. Nghia 1a mdi cham tbi mo
la mot diém anh con vén ndi lén trén man
hinh khi man hinh hién thj kiéu hinh sang.
C6 cac kiéu 16i chadm den.

LOI CHAM SANG

D6 gan cua cac 16i diém anh

Vi céc I6i diém anh va didm anh con cla
cung kiéu 16i vén gan véi mét kiéu 16i khac
c6 thé dé nhin thay hon, Philips cling néu
rd cac dung sai vé do gan cla 16i diém &nh

Dung sai 16i diém anh

D& huéng dich vu stra chiva hay thay

thé do cac 16i diém anh trong thoi han

bdo hanh, man hinh TFT trong man hinh
phang Philips phai c6 cac 16i diém anh hay
diém &nh con vuot qué nhivng dung sai
néu trong cac bang sau.

MUC CHAP NHAN

1 diém anh con sang 3
2 diém anh con sang gan nhau 1
3 diém anh con sang gan nhau (m6t diém anh trang) 0
Khodng cach gitra hai I6i chdm sang* >15mm
Téng s6 16i cham sang clia moi kiéu 16i 3

LOI CHAM BPEN

MUC CHAP NHAN

1 diém anh con t6i m& 5 hodc it hon
2 diém anh con t6i m& gan nhau 2 hoac it hon
3 diém anh con t6i m& gan nhau 0
Khodng cach gitva hai I6i chAm den* >15mm
Tbng sb 16i cham den ctia moi kiéu 16 5 hodc it hon

TONG SO LOI CHAM

Tbng s 16i chAm sang hay den ctia moi kiéu I6i

MU’C CHAP NHAN
5 hoac it hon

& Ghi chi

1. 1 hay 2 16i diém &nh con gan nhau = 1 16i chAm
2. Man hinh nay tuan th chuan 1S09241-307. (1IS09241-307: Yéu cau, phan tich v& hiéu
nang va cac phwong phap kiém tra tuan thd cho man hinh dién tir)

3. 1S09241-307 la tiéu chuén tiép theo clia tiéu chudn 1ISO13406 cii, vén da bi hdy bd bdi
T6 chirc Tiéu chuan héa Quéc té (ISO) vao ngay: 13-11-2008.
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7.2 Cham séc khach hang & Ché dé bao hanh

D& c6 théng tin chi tiét vé chinh sach bdo hanh va yéu cau héd tro thém dwoc ap dung cho
khu vuc ctia ban, vui ldng truy cap website www.philips.com/support. Ban ciing c6 thé lién
hé v&i Trung tdm cham séc khach hang dia phwong cda Philips theo sb dién thoai dwdi
day.

Théng tin lién lac cho khu viwec CHAU MY LATINH:

Quéc gia  Trung tam dich vu S6 cham séc khach hang
Brazil 0800-7254101

Vermont
Argentina 0800 3330 856

Théng tin lién lac cho khu viec NAM MY:

Qubc gia Trungtam  ASC (Trung timdich vy g4 ojx o6 khach hang
dich vu uy quyen)

U.S.A. EPI-e-center | Qwantech (877) 835-1838

Canada EPl-e-center | Qwantech (800) 479-6696

Théng tin lién lac cho khu vwc TAY AU:

Québc gia S6 cham séc khach hang  Gia

Austria RTS +43 0810 000206 €0.07

Belgium E Care +32 078 250851 €0.06

Cyprus Alman 800 92 256 Free of charge
Denmark Infocare +45 3525 8761 Local call tariff
Finland Infocare +358 09 2290 1908 Local call tariff
France Mainteq +33 082161 1658 €0.09
Germany RTS +49 01803 386 853 €0.09

Greece Alman +30 00800 3122 1223 Free of charge
Ireland Celestica +353 01 601 1161 Local call tariff
[taly Anovo ltaly +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway Infocare +47 2270 8250 Local call tariff
Poland MSI +48 0223491505 Local call tariff
Portugal Mainteq 800 780 902 Free of charge
Spain Mainteq +34 902 888 785 €0.10
Sweden Infocare +46 08 632 0016 Local call tariff
Switzerland ANOVO CH +41 02 2310 2116 Local call tariff
United Kingdom Celestica +44 0207 949 0069 Local call tariff
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Thong tin lién lac cho khu viec TRUNG VA BONG AU:

Trung tdm  ASC (Trung tam dich vu Sé chim séc khach hang

Qubc gia

dich vu Uy quyén)
+
searus | Na oA (379 17 217 3369
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300
cow aJom e
Georgia NA Esabi +995 322 91 34 71
+36 1 814 8080(General)
Hungary NA Profi Service +36 1814 8565(For AOC&Philips
only)
Kazakhstan NA Classic Service l.l.c. +7 727 3097515
+
Latvia NA ServiceNet LV +§;1 g;gzg;zz
Lithuania NA UAB Servicenet Igg ;Zo%%(?ségf(ffgﬁﬂ?gs)
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
s fegro NA KimTec doo. +381 1120 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
UREVSE |y ServiceBy +375 17 284 0203
Belarus
Turkey NA Techpro +90 212 444 4 832
s NA Comel +380 5627444225
NA Topaz +38044 525 64 95

Théng tin lién lac & Trung Quéc:

Trung Quéc
S6 cham séc khach hang: 4008 800 008
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Thong tin lién lac cho khu virc Chau A TBD/Trung BDéng/Chau Phi (APMEA):

Qubc gia

Trung tam

dich vu

ASC (Trung tam dich vu
ay quyén)

S6 cham séc khach hang

— kv a—

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / NA Company: Smart Pixels Hong Kong:Tel: +852 2619 9639
Macau Technology Ltd. Macau:Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 56677
Indonesia NA PT. CORMIC SERVISINDO +62-21-4080-9086 (Customer Hotline)
PERKASA +62-8888-01-9086 (Customer Hotline)
Korea NA Alphascan Displays, Inc. 1661 — 5003
Malaysia NA R-Logic Sdn Bhd +603 5102 3336
Pakistan NA TVONICS Pakistan +92-213-6030100
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3966
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Computer Repair Technologies | 011 262 3586
Israel NA Eastronics LTD 1-800-567000
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA Company Ltd. - Ho Chi Minh +84 5113.562666 Danang City
City Branch +84 5113.562666 Can tho Province
Philippines NA EA Global Supply Chain (02) 655-7777; 6359456
Solutions ,Inc.
Armenia
Azerbaijan
Georgia NA Firebird service centre +97 14 8837911
Kyrgyzstan
Tajikistan
Uzbekistan NA Esdmko Plus Private Enterprise +99871 2784650
Turkmenistan | NA Technostar Service Centre +(99312) 460733, 460957
! GX = = 0 7. N
et NA TAVTRESS = IR 03 5676600

29




8. Khac phuc sw co &
Hoi Pap

8.1 Khac phuc sw cb

Trang nay giai quyét cac sw cb vén nguoi
duing c6 thé khac phuc. Néu sw cb van
tiép dién sau khi ban da th&r dung céac giai
phéap trén trang nay, hay lién hé v&i dai
dién dich vu khach hang cta Philips.

H cac sw cd thweng gip

Khéng c6 hinh anh (Pén LED nguén

khéng sang) ) . .

+ Dam bao da cam day nguon vao o
cam dién va mat sau ctia man hinh.

«  Trwéc tién, ddm bao nut ngudn &
mét tredc man hinh nam & vi tri OFF
(TAT), sau d6 ddy nat sang vi tri ON
(BAT).

Khéng c6 hinh anh (Pén LED ngu6n

sang trang)

*  Dam bao da bat may tinh.

«  DPam bao cap tin hiéu da dwoc két nbi
duang céach véi may tinh clda ban.

+ Dam bdo cap man hinh khéng cé cac
chau cam bj cong trén mat két nbi.
Néu c6, hay stra hay thay méi cap.

« C6 thé da bat tinh nang Tiét kiém
nang lvong

Man hinh théong bao

Attention

Check cable connection

+ Dam bao cap man hinh da duoc két
ndi dung cach véi may tinh cta ban.
(Ciing tham khao Hwéng dan khéi
déng nhanh).

*  Kiém tra xem cap man hinh c6 cac
chau cam bi cong hay khdng.

*  Dam bao da bat may tinh.
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Nut AUTO (Tw dong) khéng hoat dong

«  Chtc néng tw ddng chi ap dung & ché
dd VGA- Analog. Néu khong hai long
véi két qua, ban co thé thuc hién cac
didu chinh tht cdng qua menu OSD
(hién thi trén man hinh).

& Ghichu
Chtrc nang Auto (Tw dong) khdéng ap dung
& ché do DVI-KTS vi n6 khong can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay

« Khéng thuc hién bat ky buéc khic
phuc sy ¢ nao

«  Ngét ngay két ndi man hinh khdi 6
cam dién chinh cho an toan

* Lién hé ngay vé&i dai dién dich vu
khach hang cta Philips.

B cac swc hinh anh

Hinh anh khéng nam giiva tam man

hinh

«  Chinh vj tri hinh &nh qua chlrc nang
“Auto (Tw dong)” trong cac nut diéu
khién chinh trén menu OSD.

* Chinh vj tri hinh anh qua Phase/Clock
(Géc pha/bdng hd) clia Setup (Cai
dat) trong cac nuat diéu khién chinh
trén menu OSD. N6 chi co hiéu lwc &
ché do VGA.

Hinh anh rung lén trén man hinh

« Kiém tra xem cap tin hiéu da dwoc
cam chét dung cach vao bang mach
dd hoa hay may tinh hay chua.

Hién thij hién twong chap chén doc

* Chinh hinh anh qua chtrc nang “Auto
(Tw déng)” trong cac nuat diéu khién
chinh cda menu OSD.



» Loai bé céac vach doc qua Phase/
Clock (Géc pha/Bdng hd) cliia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co hiéu
lwc & ché d6 VGA.

Hién thi hién twong chap chen ngang

* Chinh hinh anh qua chirc nang “Auto
(Tw doéng)” trong cac nuat diéu khién
chinh ctia menu OSD.

» Loai bd céac vach doc qua Phase/
Clock (Géc pha/Ddng hd) clia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co hiéu
lwc & ché do VGA.

Hinh anh hién thi nhoe, khong ré hoac

qua mo

« Chinh d6 twong phan va do sang trén
menu Hién thj trén man hinh (OSD).

Hién twong “anh ao”, “anh thir nong”
hay “anh béng ma” van hién thj sau khi
da tat nguén.

+ Hién thi lién tuc cac anh tinh trong mot
thoi gian dai c6 thé gay ra hién twong
“anh thir néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thir néng”, “Anh a0”
hay “Anh béng ma” la hién twong phd
bién trong cong nghé man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh thtr nong” hoac “anh ao”
hay “anh béng ma” sé dan dan bién
mat sau moét thdi gian man hinh bi
ngét dién.

e Ludn bat trinh bdo vé man hinh
chuyé&n ddng khi ban khéng st dung
man hinh.

e Lubn bat (rng dung lam m&i man hinh
dinh ky, néu khéng, man hinh LCD
cda ban sé hién thi nhirng ndi dung
tinh khong thay déi.

31

» Cac hién twong “anh thir néng” hay
“anh ao0” hay “anh béng ma” sé khong
biét mat va ban can mang man hinh
di stra. Thiét hai nhw trén khéng ndm
trong chinh sach bdo hanh ctia ching
toi.

Hinh hién thij bién dang. Van ban bi m&

hoac nhoe.

« Cai do phan gidi man hinh may tinh
sang cung ché dd véi do phan giai
man hinh géc khuyén duing ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thj trén man hinh

« Céc cham con lai la d4c tinh théng
thworng cGia man hinh tinh thé 1éng
dung trong cdng nghé ngay nay. Vui
léng tham khao chinh sach diém anh
dé biét thém thong tin.

DPén “bat ngudn” qua sang va gay choi

mét

+ Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED ngudn trong cac nut
digu khién chinh ctia menu OSD.

Pé duwoc tro gitip thém, hay xem danh
sach Trung tdm thong tin khach hang
va lién hé va&i dai dién dich vu cham séc
khach hang cta Philips.



8.2 Héi bap chung

H1:

Khi cai cai dit man hinh, t6i can
lam gi néu man hinh hién thj
“Cannot display this video mode”
(Khong thé hién thi ché do video
nay)?

Pap: D6 phan giai khuyén dung cho man

hinh nay la: 1600 x 900 @60 Hz.
Ngat tAt ca cac cap roi két néi PC véi
man hinh ma ban da dung trwdc do.
Trong Windows Start Menu (Menu
kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang didu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
co tén “desktop area (vung man hinh
nén)”, chuyén thanh trwot sang murc
1600 x 900 pixels.
Mé& thé “Advanced Properties” (Thudc
tinh nang cao) va cai Mirc cap nhat
(Refresh Rate) sang 60Hz rdi click
OK.

Khéi dong lai may tinh va lap lai bwéc
2 va 3 dé kiém tra xem PC ctia ban da

dwoc cai sang mrc 1600 x 900 @60
Hz hay chua.

Tét may tinh, ngét két ndi man hinh
cli va két ndi lai man hinh LCD Philips
cla ban.

T&t man hinh rdi bat lai PC.

H2: Mdrc cap nhat khuyén dung cho

bap:

man hinh LCD la bao nhiéu?

Murc cap nhat khuyén dung cho man
hinh LCD la 60Hz. Néu c6 bt cir
hién twong nhiéu nao trén man hinh,
ban c6 thé cai dat mrc ndy sang
75Hz dé kiém tra xem mirc m&i nay
c6 loai bd dugc hién twong nhiéu
hay khong.
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H3:

bap:

H4:

bap:

H5:

bap:

H6:

bap:

H7:

bap:

Cac file .inf va .icm trén dia CD

1a gi? Lam thé nao dé cai dit cac
driver (.inf va .icm)?

Day la cacfil driver cho man hinh
cla ban. Thuc hién theo cac chi dan
trong sb tay str dung dé cai dat cac
driver nay. May tinh c6 thé yéu ciu
ban cai cac driver man hinh (fil .inf
va .icm) hodc Iap dia driver khi ban
cai dat man hinh lan dau. Thyc hién
theo cac chi dan dé I&p (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (fil .inf va .icm) sé
dwoc cai dat ty dong.

Lam thé nao dé chinh doé phan giai?
Card video/driver dd hoa cla ban

va man hinh sé ciing quyét dinh

cac do phan giai c6 sin. Ban co thé
chon do phan giai mong mudn trong
Control Panel (Bang diéu khién)
clia Windows® qua thé “Display
properties” (Thudc tinh man hinh).
Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nat OK rdi chon
“Reset” (Cai dét lai) d& phuc hdi moi
cai d&t mac dinh gbc.

Man hinh LCD c6 kha ning chéng
tray xwérc?

N6i chung ban khéng nén dé& bé mat
man hinh va cham qua muc véi cac
vat khac hay va bao vé né khai cac
vat dung sac hay cun. Khi cAm man
hinh, d@m bao khong dung strc ép
hay lwc manh 1&n phia b& mat man
hinh. Diéu nay cé thé anh hwéng
dén céac diéu kién bao hanh cda ban.

T6i nén lau man hinh LCD nhw thé
nao?

Dé lau thong thuong, hay sir dung
khan sach va mém. Dé lau ky, hay
duing cén isopropyl. Khéng dung
cac dung méi khac nhw con étylic,
ethanol, axeton, hexan, v.v...



H8: Toi co thé thay déi cai dat mau
séc cho man hinh?

Dap: Di nhién, ban c6 thé thay dbi cai
dat mau sic qua nut didu khién trén
menu OSD theo cac quy trinh sau,

. Nhén “OK” dé hién thi menu OSD
(Hién thi trén man hinh)

. Nhan “Down Arrow” (Mi tén
xudng) dé chon tuy chon “Color”
(Mau) rdi nhan “OK” dé vao cai dat
mau; c6 ba Ilwa chon mau nhu sau.

1. Color Temperature (Nhiét d6 mau);
Hai cai dat gdm 6500K va 9300K.
V@i cac cai dat trong pham vi
6500K, man hinh sé hién thj “néng
vé&i tin hiéu mau dé-trang", trong khi
nhiét do 9300K tao ra “mat v&i tin
hiéu mau lam-trang’.

2. sRGB (Pd-Luc-Lam chuén); day
la cai d&t chudn dé& dam bao trao
ddi mau thich hgp gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Defin (Tw chon); nguwoi dung
c6 thé tw chon cai dat mau sac wu
tién bang cach chinh mau dé, luc va
lam.

& Ghichu

Do mau anh sang téa ra ttr mot vat dung

trong khi né dwoc lam néng. Sé do nay

dwoc thé hién dwa trén ty 18 tuyét déi, (mirc

dd Kelvin). Cac mirc nhiét d6 Kevin thap

hon nhw 2004K la mau dé; cac mire nhiét

dod cao hon nhw 9300K la mau lam. Nhiét
dé trung tinh 1a mau tréng & mirc 6504K.

H9: Téi c6 thé két n6éi man hinh LCD

vé&i moi PC, may cha hay may
Mac?

DPap: C6 thé. TAt ca cac man hinh LCD
Philips d&u hoan toan twong thich
v&i cac PC, may Mac va may chu
chuan. Ban c6 thé can cé dau noi
cap dé két néi man hinh méi hé
théng may Mac. Vui Idng lién hé voi
nhan vién kinh doanh ctia Philips dé
biét thém thong tin.

H10: Man hinh LCD Philips cé hé tro
chuén Plug-and-Play (Cadm vao la
phat)?

DPap: C6, cac man hinh Philips déu h tro
chuén Plug-and-Play twong thich
v&i Windows 8/ Windows 7/ Vista/
XP/NT, Mac OSX, Linux

H11: Anh chap chon hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

DPap: Hién thj lién tuc cac anh tinh trong
mot thdi gian dai cé thé gay ra hién
twong “anh th&r nong”, con dwoc
goi la “anh ao” hay “anh bong ma”,
trén man hinh cta ban. “Anh thte
néng”, “Anh ao” hay “Anh béng ma”
I& hién twong phd bién trong cong
nghé man hinh LCD. Trong moi
trwong hop, hién twong “anh thi
néng” hay “anh ao” hay “anh béng
ma” sé& bién mét dan trong mét thoi
gian sau khi da tat nguon.

Luén bat trinh bao vé man hinh
chuyé&n ddng khi ban khéng st
dung man hinh.

Ludn bat vng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD cla ban sé& hién thj nhirng noi
dung tinh khéng thay ddi.

O canh bao

Khéng thé bat anh bao vé& man hinh, hoac
trng dung cap nhat man hinh dinh ky co
thé gay ra cac sw ¢ “thtr ndng” hodc “anh
sau” hoac “anh bong ma” nghiém trong
vbn sé& khong bién mét va ciing khéng

thé khac phuc. Thiét hai vira néu khéng
bao gbm trong chinh sach bao hanh cla
chung téi.

H12: Tai sao man hinh cua t6i hién thj
van ban sac nét va cac ky tw ring
cwa?

Pap: Man hinh LCD cla ban hoat déng
tbt nhat & dod phan giai gbc 1600 x
900 @ 60 Hz. D& man hinh hién thj
tdt nhét, vui long st dung dd phan
gidi nay.
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